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Introduction to Internet and Web Browser

The Internet is a global system of interconnected computer networks that use the standard Internet Protocol
Suite (TCP/IP) to serve billions of users worldwide. It is a network of networks that consists of millions of
private, public, academic, business, and government networks, of local to global scope, that are linked by a
broad array of electronic and optical networking technologies. The Internet carries a vast range of
information resources and services, such as the inter-linked hypertext documents of the World Wide Web
(WWW) and the infrastructure to support electronic mail.

Most traditional communications media including telephone, music, film, and television are being reshaped
or redefined by the Internet. Newspaper, book and other print publishing are having to adapt to Web sites
and blogging.

The Internet has enabled or accelerated new forms of human interactions through instant messaging,
Internet forums, and social networking. Online shopping has boomed both for major retail outlets and small
artisans and traders. Business-to-business and financial services on the Internet affect supply chains across
entire industries.

The Internet has no centralized governance in either technological implementation or policies for access and
usage; each constituent network sets its own standards. Only the overreaching definitions of the two
principal name spaces in the Internet, the Internet Protocol address space and the Domain Name System, are
directed by a maintainer organization, the Internet Corporation for Assigned Names and Numbers (ICANN).

Web Browsers

A web browser or Internet browser is a software application for retrieving, presenting, and traversing
information resources on the World Wide Web. An information resource is identified by a Uniform
Resource Identifier (URI) and may be a web page, image, video, or other piece of content. Hyperlinks
present in resources enable users to easily navigate their browsers to related resources.

Although browsers are primarily intended to access the World Wide Web, they can also be used to access
information provided by Web servers in private networks or files in file systems. Some browsers can also be
used to save information resources to file systems.

Surfing the web is made possible by Web browsers. Browsers are basically software programs that allow
you to search for and view various kinds of information on the Web, such as web sites, video, audio, etc.
Short for Web browser, a software application used to locate and display Web pages.

The Most Popular Web Browsers

Here are just a few of Web browsers available to you for a free download:

 Microsoft's Internet Explorer: Most Internet users are using Internet Explorer because it's easy to use and
most Web sites are written with Internet Explorer in mind, meaning that they are compatible.

 Opera: Opera is another popular browser that's easy to use; however, it can have some compatibility
issues with various websites.

 Mozilla's Firefox: Firefox is rapidly gaining ground right behind Internet Explorer because of its tabbed
browsing, superior security features, and fast load.
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Search Engines

A web search engine is designed to search for information on the World Wide Web and FTP servers. The
search results are generally presented in a list of results and are often called hits. The information may
consist of web pages, images, information and other types of files.

A program that searches documents for specified keywords and returns a list of the documents where the
keywords were found. Although search engine is really a general class of programs, the term is often used to
specifically describe systems like Google, Alta Vista that enable users to search for documents on the
World Wide Web and USENET newsgroups.

Typically, a search engine works by sending out a spider to fetch as many documents as possible. Another
program, called an indexer, then reads these documents and creates an index based on the words contained
in each document. Each search engine uses a proprietary algorithm to create its indices such that, ideally,
only meaningful results are returned for each query

Popular Search Engines

Google Google - The world's most popular search engine.
Bing Bing Search: Microsoft's entry into the burgeoning search engine market.

Better late than never.
Altavista AltaVista: Launched in 1995, built by researchers at Digital Equipment

Corporation's Western Research Laboratory. From 1996 powered Yahoo!
Search, since 2003 - Yahoo technology powers AltaVista.

AOL Search search.aol: Now powered by Google. It is now official.
LYCOS Lycos: Initial focus was broadband entertainment content, still a top 5

Internet portal and the 13th largest online property according to Media
Metrix.

GIGA BLAST GigaBlast was developed by an ex-programmer from Infoseek. Gigablast
supports nested boolean search logic using parenthesis and infix notation. A
unique search engine, it indexes over 10 billion web pages.

ALexa Alexa Internet: A subsidiary of Amazon known more for providing website
traffic information. Search was provided by Google, then Live Search, now
in-house applicaitons run their own search.

Saving web pages

With Internet Explorer 6 in Windows XP, you can make a Web page available offline and view it when your
computer is not connected to the Internet.

To make the current Web page available offline

1. On the Favorites menu, click Add to Favorites.
2. Select the Make available offline check box.
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3. To specify a schedule for updating that page, and how much content to download, click
Customize.

4. Follow the instructions on your screen.

To make an existing favorite item available offline

1. On the Favorites menu, click Organize Favorites.
2. Click the page you want to make available offline.
3. Select the Make available offline check box.
4. To specify a schedule for updating that page, and how much content to download, click

Properties.

To view Web pages without being connected to the Internet

After you mark your favorite pages for viewing offline, you can view them offline by following these steps

1. Before you disconnect from the Internet, on the Tools menu, click Synchronize.
2. When you're ready to work offline, on the File menu, click Work Offline. Internet Explorer

will always start in Offline mode until you click Work Offline again to clear the check mark.
3. In your Favorites list, click the item you want to view.

You can also make Web pages available offline without adding them to your Favorites list, by saving the
pages on your computer.

Follow these steps

1. On the File menu, click Save As.
2. Double-click the folder you want to save the page in.
3. In the File name box, type a name for the page.
4. In the Save as type box, select a file type.
5. Do one of the following:

• To save all of the files needed to display this page, including graphics, frames, and style sheets, click
Web Page, complete. This option saves each file in its original format.

• To save all of the information needed to display this page in a single MIME-encoded file, click Web
Archive. This option saves a snapshot of the current Web page. This option is available only if you
have installed Outlook Express 5 or later. When you choose Web Page, complete, only the current
page is saved. With Web Page, complete and Web Archive, you can view all of the Web page
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offline, without adding the page to your Favorites list and marking it for offline viewing.

• To save just the current HTML page, click Web Page, HTML only. This option saves the
information on the Web page, but it does not save the graphics, sounds, or other files.

• To save just the text from the current Web page, click Text Only. This option saves the information
on the Web page in straight text format.

Downloading files and software

Downloading is the transmission of a file from one computer system to another, usually smaller computer
system. From the Internet user's point-of-view, to download a file is to request it from another computer (or
from a Web page on another computer) and to receive it.

Uploading is transmission in the other direction: from one, usually smaller computer to another computer.
From an Internet user's point-of-view, uploading is sending a file to a computer that is set up to receive it.
People who share images with others on bulletin board systems (BBS) upload files to the BBS.

The File Transfer Protocol (FTP) is the Internet protocol for downloading and uploading files and a number
of special applications can furnish FTP services for you.

Portable Document Format files (.PDF)

Portable document format was designed to preserve a document's page layout, regardless of the computer
platform being used. To view or download these files you need Adobe Acrobat Reader which can be
downloaded for free from the Adobe site. Note that unless you acquire special software, pdf documents
cannot be modified even if you download them.

Microsoft Word files (.doc)

Downloading MS Word files and opening them using MS Word. Word files can also be viewed using
special viewers such as Quick View Plus, but page layout and paragraph numbering may differ from the
original document.

Executable files (.exe)

Executable or .exe files perform an action when run locally on your computer once they have been
downloaded and saved on your hard disk. For example, an .exe file might decompress itself to produce a
number of documents, or it might install software when you run it by double-clicking.

Zip files (.zip)

Zip is a compression format used to reduce downloading times. “Zipped” files can be decompressed using
software freely available from http://www.winzip.com/
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Email: writing and sending to single and multiple users

Email : Writing E-mails to single and multiple users. Attaching a file,  Marking CC  and BCC,
Creating

exclusive communication group.
LCD Projector :  Using LCD projector for making an audio-visual presentation.
Tele/Video Conferencing
Blogging and Chating
Fax and Mobiles

E-Mail (Electronic mail):
Definition: Email, e-mail or electronic mail is the transmission of messages (emails or email
messages) over electronic networks like the internet.

OR
Electronic mail, commonly called email or e-mail, is a method of exchanging digital messages
across the Internet or other computer networks.

 Advantages:

 Freedom of movement

 Easy to use

 Free

 Always available

 You can send letters, notes, files, data, or reports

 Disadvantages:

 Limited storage space for messages.

 No offline access to your email.

 E-mail in Four Parts

 The Address

 The Attachment

 The Subject Line

 The Body
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 General format of E-mail:

An email address usually consists of 2 elements:
name@company.organization code.country code

Examples of email addresses for people in the United States:
abc@gmail.com
abc@palm.co.in

 How to Attach a File to an Email:

Emails are a popular, effective, and fast way to communicate. Attaching a file to an email is an easy way
to send important documents and/or photos.
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 Sending an Email to Multiple Recipients - Cc: and Bcc:

 CC (Carbon Copy) : Everyone in the To and CC are visible.

When you send a message to more than one address using the Cc: field, both the original
recipient and all the recipients of the carbon copies see the To: and Cc: fields including all
the addresses in them.

 Bcc(Blind Carbon Copy): Its totally invisible so nobody can see it.
A BCC (blind carbon copy; also Bcc) is a copy of an email message sent to a recipient whose
email address does not appear in the message.

 Creating Groups:

Step 1 : Click on the "Contacts" tab on your left panel.

This will open your Contacts page where most of your contacts will be located under "Other Contacts".

Step 2 : Click on "New Group" to create an mailing list or a group of email contacts.

I am choosing Science Grp. as the name. Click OK

Step 3 : Once you have created the email group. Go to your "Other Contacts" tab and select the people you
want to add in your new mailing group.
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Step 4 : After selecting people, click "Groups" from the menu list and select the group you want to add
those contacts to. (Science Grp in this case)

Done… Now you can send email to group in Gmail. You can create different groups for different reasons,
ultimately it about sending one email to many people at once easily.

Mobile:

 A mobile phone (also called mobile, cellular telephone, cell phone,) is an electronic device
used for two-way radio telecommunication over a cellular network

 A cellular phone is a portable telephone that does not use a wired connection. It connects to a
wireless carrier network using radio waves.

 Main Uses for Mobile Phones:

The most popular uses and applications for mobile phones are:

 Voice calling – Talking on the telephone.
 Voice mail – Callers can leave a message if your phone is busy or turned off.
 E-mail – Send and receive e-mails with other e-mail addresses.
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 Messaging – Send and receive text, picture and instant (chat) messages with other mobile phone
users and e-mail addresses. See Text Messaging Acronyms and Abbreviations.

 Mobile content – Get news, weather, sports, financial and other information from mobile service
providers or from Internet Web sites.

 Gaming – Play games that are downloaded to your handset or played online on the Internet.
 Personalize your phone – to your own style by adding custom ringtones, ringback tones, face-plates,

themes, background images, icons, voice greetings and screen-savers.
 Play music – using an audio (MP3) player to play downloaded tracks or listen to radio.
 Take photos or videos – with a built-in camera. Then send the image files to others.
 Download and view images – with a photo (JPEG) viewer or video (MPEG) player.
 Organize personal information – using a calendar, clock, alarm, address book, task manager or

memo pad.
 Shop – Make retail purchases from Web-based stores (e-commerce).
 Bank – Manage your money using an e-wallet.
 Location-based services – Maps & directions. Retail store directory. Track persons, cars, pets, etc.

 Types of Mobile Phone Handsets

There are five types of mobile phone handsets and devices. The lines between the types are blurring
as each one adopts certain features of the others:

Standard cellular phone – Also called a cell phone, mobile phone or wireless phone. Provides basic
mobile phone features. Some models provide advanced features such as ringtones, camera and push-
to-talk.

Smart phone – Smart phones are cell phones with advanced digital media features such as e-mail,
messaging, web browsing, audio, video, personal information management and text/data entry.

Apple offers the popular iPhone touch-screen handset.

The most common Smartphone operating system is the Symbian platform. Symbian PLC is a
software development consortium owned by Nokia, Ericsson, Sony Ericsson, Panasonic, Siemens
and Samsung.

PDA phone – PDA phones are wireless Personal Digital Assistant devices that have evolved into
providing cell phone-like features.

Major manufacturers are Palm One, Hewlett-Packard and Dell. Popular operating systems are Palm
OS and Microsoft Mobile Pocket PC.

BlackBerry – Made by Research In Motion Inc. is a portable device for e-mail and phone. It has a
small easy-to-use keyboard for simple e-mail, massaging , attachment viewing, WML/HTML
browsing and voice calling. Service is provided by partner wireless carriers around the world.

Satellite phone – Use a system of earth-orbiting satellites to connect a mobile phone to the public
telephone networks. Major handset manufacturers are . Motorola.



US04SICT51                                 B.Sc. – Ccomputer Science Semester – IV Unit - I

10

The main advantage of satellite phone service is total worldwide coverage. Disadvantages are audio
delay, signal interference and high costs.

FAX :( Facsimile)

 A fax (short for facsimile) is a document sent over a telephone line.

OR

 A facsimile or "fax" machine sends a document image over telephone lines to a distant receiver.

OR

 A facsimile machine, or fax machine, scans a document and transmits a copy of the document over
a telephone line or an Internet protocol (IP) network.

 Fax machines are an integral part of businesses worldwide. Although the Internet is often used for
faxing purposes, the fax machine is still important in the workplace.

 Fax machines have existed, in various forms, since the 19th century, though modern fax machines
became feasible only in the mid-1970s as the sophistication of technology increased and cost of the
three underlying technologies dropped.

 Digital fax machines first became popular in Japan, where they had a clear advantage over
competing technologies like the teleprinter.


